Table of Contents

I. General Procedures
   1. Training Literature................................................................. page 5
   2. Basic Safety............................................................................. page 5
   3. Basics of SPR........................................................................ page 5
   4. SPR Instrument and Peripherals.............................................. page 8
      A. Instrument........................................................................ page 8
      B. Syringe pumps................................................................. page 8
      C. Buffer system................................................................. page 9
      D. Instrument LEDs........................................................... page 9
      E. Autosampler................................................................. page 10
      F. Sample holders............................................................. page 11
      G. Waste collection tank................................................... page 11
      H. Microfluidics................................................................. page 12
      I. MCM................................................................................. page 12
      J. Optical Detection system................................................ page 12
   5. Basics of SPR Experiment.................................................... page 13
   6. Sensor Chips......................................................................... page 15
      A. Types of Sensor Chips................................................... page 15
      B. Handling of Sensor Chips............................................... page 17
      C. Maintenance Chip........................................................ page 18
   7. ProteOn Manager Software Overview.................................... page 19
      A. Instrument Control screen............................................. page 19
      B. Priming.......................................................................... page 19
      C. Buffer Solutions........................................................ page 19
      D. Setting Chip Temperature............................................. page 20
      E. Ejecting Chip.................................................................... page 20
      F. Initializing Chip................................................................ page 20
   8. Experiment Design............................................................... page 21
      A. Experiment Steps........................................................... page 21
         1) Planning and Preparation.......................................... page 21
         2) Conditioning of Sensor Chip..................................... page 22
         3) Pre-Concentration....................................................... page 22
         4) Immobilization........................................................ page 23
            a) Direct Coupling..................................................... page 23
            b) Noncovalent Capturing........................................ page 26
         5) Deactivation................................................................ page 26
         6) Stabilization.............................................................. page 26
         7) Interaction................................................................ page 27
         8) Regeneration................................................................ page 28
      B. Conditioning of Sensor Chip............................................. page 29
1) GLC, GLM, GLH Sensor Chips ................................................................. page 29
2) NLC Sensor Chips ............................................................................ page 30
3) HTG Sensor Chips ............................................................................ page 30
C. Reusing Sensor Chips ....................................................................... page 31

9. Running an Experiment ..................................................................... page 31
   A. Starting Bio-Rad XPR36 Instrument .............................................. page 31
   B. Initializing sensor chip ................................................................. page 31
   C. Write a protocol ........................................................................... page 31
   D. Run a protocol ............................................................................ page 32
   E. Instrument Maintenance .............................................................. page 32
   F. Export experiment files .............................................................. page 32

10. Creating a Protocol ................................................................ ............ page 32
   A. Creating a Protocol from a Template ......................................... page 32
   B. How to edit a Protocol or Template ............................................ page 34
   C. How to save a Protocol or Template .......................................... page 35
   D. Creating a Protocol from Rack contents ................................... page 36
   E. Configuring Protocols ............................................................... page 36
   F. Editing Protocol Sample details ............................................... page 37
   G. Sample Panel Browser .............................................................. page 38
   H. Creating and Editing Protocol Steps .......................................... page 39
   I. Setting Injection Steps ............................................................... page 40
   J. Step Group List ........................................................................... page 41
   K. Copying and Pasting Protocol steps ........................................... page 42
   L. Editing Injection Steps ............................................................... page 42
   M. Protocol Step Details ................................................................ page 43
   N. Interaction Viewer ....................................................................... page 43
   O. Setting Buffer Step ...................................................................... page 44
   P. Setting Temperature Step ........................................................ page 44
   Q. Setting Change Rack Step ........................................................ page 45
   R. Setting Pause Step ....................................................................... page 45
   S. Protocol Check ............................................................................ page 46

11. Activating G-Series Sensor Chips .................................................... page 46
12. Running Experiments ....................................................................... page 47
13. Referencing ...................................................................................... page 49
   A. Blank Surface referencing ........................................................ page 50
   B. Blank Buffer Referencing ........................................................ page 51
14. Analysis ............................................................................................ page 53
   A. Sensorgram Data Windows ........................................................ page 53
   B. Zoom ......................................................................................... page 54
   C. Showing interspot data .............................................................. page 54
   D. Data filters and display controls ................................................. page 54
   E. Isoaffinity graph ......................................................................... page 55
15. Processing Data................................................................. page 56
   A. Selecting a range on a sensorgram................................. page 56
   B. Auto Process............................................................... page 57
   C. Injection Alignment...................................................... page 57
   D. Artifact Removal....................................................... page 57
   E. Performing Reference subtraction................................. page 57
       1) Channel Reference.................................................. page 57
       2) Double Reference.................................................. page 58
   F. Remove Processing..................................................... page 58
   G. Creating Report Point................................................ page 58
   H. Creating a dataset..................................................... page 58
16. Analyzing Data............................................................... page 58
   A. Kinetic Analysis Wizard............................................... page 58
   B. Equilibrium Analysis Wizard....................................... page 61
   C. Concentration Analysis Wizard.................................... Page 63
17. Saving and Exporting Data............................................... page 65
   A. Exporting Data to File................................................ page 65
18. Post-Experiment Cleaning................................................. page 66
20. Ordering Information from Bio-Rad.................................... page 70
   A. Amine Coupling Kit.................................................... page 70
   B. Immobilization Kit.................................................... page 70
   C. Regeneration Kit...................................................... page 71
   D. Running Buffers...................................................... page 71
   E. Accessories............................................................ page 72
   F. Sensor Chips........................................................... page 72
I. General Procedures

1. Training Literature and References
   A. Operating Guide for SPR.pdf
   C. ProteOn Sensor Chips Tips and Techniques.pdf
   D. MCL BASIC LABORATORY SAFETY RULES
   E. Ligand Immobilization Guide.pdf
   F. Analyte Interaction and Kinetics.pdf
   G. SPR Data Processing Guide.pdf
   H. Excluded Volume Correction.pdf
   I. SPR Experiment on GL-X series Sensor Chip.pdf

2. Safety
   a) Follow MCL BASCIS LABORATORY SAFETY RULES.
   b) Always wear safety glasses or googles in Laboratory.
   c) Wear gloves when pipetting and handling materials.
   d) Never open sample compartment during run.
   e) Clean up area after experiment.
   f) Check waste container. Do not overflow. Dispose of waste properly.

3. Basics of SPR

Proteins play a crucial role in cell structure and function. Proteins can rapidly form specific non-covalent complexes with one another and with other macromolecules. These protein-protein interactions play a key role in most cellular processes including signaling, transport, immune system, and metabolism. Characterization of proteins is the first step to understanding how a protein participates in the biological process. The second step is to understand how a protein functions: What binding partners exist? Is this protein involved in a network? How does one protein interface with another? What are the binding dynamics? SPR can help answer these questions.

SPR stands for Surface Plasmon Resonance. SPR occurs when a polarized light strikes an electrically conducting surface at the interface between two media. This generates an electron charge density wave called plasmons reducing the intensity of reflected light at a specific angle known as the resonance angle, in proportion to the mass on a sensor surface. Target molecules (proteins) are immobilized on a prepared gold sensor surface and a sample containing the potential interacting partner in solution is flowed over the surface. During the course of the interaction, polarized light is directed toward the sensor surface and the angle of minimum intensity reflected light is detected. This angle changes as molecules bind and dissociate. SPR takes advantage of the ability to measure refractive index changes at the surface of a gold layer, and these changes are proportional to mass concentrations at the surface of the chip. See Figure 1 below.
A prism-like chip is coated with a thin layer of gold which is illuminated and surface plasmons are excited at the metal/dielectric sensor surface by the absorption of incident light under conditions of total internal reflection.

**Features of SPR:**

- Prism of high refractive index optical glass
- Gold Surface
- SPR signal is directly proportional to refractive index change at the metal-solution surface (i.e.) SPR signal is proportional to mass of biomolecules deposited to the surface.

SPR provides analysis of specificity, affinity and kinetics of biomolecular interactions. Biomolecular interactions include:

- protein-protein
- DNA-protein
- protein-peptide
- DNA-DNA
- Antibody-Antigen
- carbohydrate-protein
- protein-small molecule
- lipids
A typical SPR experiment first immobilizes the ligand (a biomolecule such as protein or nucleic acid) to the functionalized surface of the sensor chip and then flowing an analyte (an interacting biomolecule such as a protein or another small molecule) over the chip surface to investigate the binding affinity and binding kinetics between the analyte and the ligand. This binding is tracked by following the change in SPR signal over time. The time traced graph is called a sensorgram. Parameters such as association rate, dissociation rate and equilibrium constant can be calculated. The binding response initially increases as analyte is flowed over the sensor ship and associated with the immobilized ligand. The binding response decreases as the analyte solution is replaced with buffer and the binding complex dissociates. If binding equilibrium is reached during the association phase, the sensorgram will reach a constant plateau before the analyte solution is replaced with buffer and the binding complex dissociates.

\[
A + B \xrightleftharpoons[k_d]{k_a} AB
\]

SPR characterizes these aspects of biomolecular interaction:

- **Specificity of the interaction**
- **Rate of the interaction** ($K_a$=Association Rate Constant)
- **Stability of the complex** ($K_d$= Dissociation Rate Constant)
- **Strength of the interaction** [$K_D (K_D = K_d/K_a)$]

**A. Instrument**

The main components of the SPR instrument are the chip loader, autosampler, microfluidics system, and optical unit where SPR measurements take place. The instrument is made up of four main compartments: autosampler, buffer bottles, chip and syringe pumps. Autosampler and buffer compartments are behind clear hinged magnetic doors. The chip loader is directly accessible. The syringe pumps are protected by clear screw secured door.

![Instrument](image)

**B. Syringe Pumps**

These are located on the side of the instrument. On the left are the Sample syringe pumps, and on the right are the Buffer syringe pumps. Just take a look for any signs of salt or debris, and/or wear and tear.

![Syringe Pumps](image)
C. Buffer system

It can hold two 2L bottles. There are two lines that are labeled Buffer A and two lines labeled Buffer B. Both lines must be in a solvent. It can be the same buffer.

D. Instrument LEDs

On the front left of the instrument, there is a vertical panel of LEDs for instrument status, chip temperature, autosampler temperature, autosampler status, and experiment status. They should be green for “ready” or orange flashing for “in progress”. Red is a sign of a problem.
E. Instrument Fans

The SPR instrument has 3 cooling fans in the back. **Do not block or cover these fans!**

![Instrument Fans Image]

F. Autosampler

The autosampler component contains a needle holder, thermal platform, 3 sample holder sensors, and needle wash station.

- **You must have 2 racks in autosampler at all times!** There are 3 sensors in the back of the platform to detect sample holders.
- Do not open door during run and interfer with needles. Please abort or stop run.
- Be sure plates are loaded correctly
- Thermal temperature platform can be set from 2°C to 35°C.

![Autosampler Image]
G. Sample Holders

We have two types of sample holders.

1. **ProteOn Standard Microplate** - a 96 well array that holds 350µl.

![ProteOn Standard Microplate Image]

2. **ProteOn Deep-Well Microplate** - a 96 well array that holds 2.0ml (used for post-experiment cleaning)

![ProteOn Deep-Well Microplate Image]

H. Waste Collection Tank

All the waste is collected in the white container to the right of the unit on the floor. Please be sure this tank will not overflow. Dispose of waste properly.

![Waste Collection Tank Image]
I. Microfluidics System Components

The microfluidics system controls the flow of the samples (green) and buffer (blue) over the sensor chip. The multichannel module (MCM) directs the flow through the six channels across the surface of the sensor chip.

J. Multichannel Module (MCM)

The MCM has 6 channels. When pressed onto the surface of the sensor chip, the MCM forms a set of 6 flow channels. Ligand flows through the channels in the vertical direction during immobilization. Analyte flows through the channels in the horizontal direction. This creates the 36-element interaction array.

K. Optical Detection System

The shift of SPR angle is detected using a synchronized angular scanning illumination and array imaging detection system as the illumination angle passes through the critical angle. The optical detection system illuminates the chip at successive angles of incidence. The detection system generates an image of the light reflected at each incident angle. This segments the images into regions of interest corresponding to the 36 interaction spots. 36 resonance curves are generated.
The parts of the optical detection system are the light source, the sensor chip, which is a gold-coated glass prism, the imaging optics, and the camera (CCD = charge-coupled device). The camera collects the light reflected from the surface of the chip.

5. **Basic SPR Experiment:**
   1. Activate the COOH groups on the surface layer of the chip.
   2. Covalently bond ligand via amine coupling.
   3. Deactivate activated groups on the surface.
   4. Flow over the analyte.
   5. Monitor and measure interaction.
   6. Analyze data to determine association and dissociation rates.
   7. Regenerate Ligand layer for more interaction analysis.

A. **First 3 steps; Immobilization**
   1) Activate the COOH groups on the surface layer.
   2) Covalently bond ligand via amine coupling.
   3) Deactivate activated groups on the surface.
B. Second Series of Steps; Interaction

4) Flow over the Analyte and measure how fast it binds to the ligand.
5) Optimally wait for equilibrium binding.
6) Remove Analyte from flow.
7) Regenerate the ligand layer.

One-Shot Kinetics™ approach: The Bio-Rad SPR has six parallel flow channels, and a novel method of creating a 36 spot array by rotating the configuration of the 6 flow cells 90°. This system integrates a 6 x 6 interaction array for the analysis of up to 6 ligands with up to 6 analytes, producing 36 data points in a single experiment.

Six flow paths can be used in the vertical direction during immobilization phase to prepare in parallel 5 lanes of target. The flow paths can be automatically rotated to horizontal position allowing it to test the binding of six different analytes simultaneously. Each analyte will pass over six different target surfaces that are located on horizontal channel. There are reference spots located in the horizontal channel immediately before and after each reaction spot to allow for internal referencing.
Figure 3: Interspot references are located in the horizontal and vertical channel flow path of the sensor chip, immediately before and after each reference spot.

   
   A. There are several different sensor chips for the SPR:
      1. GLC Sensor Chip-General layer compact
      2. GLM Sensor Chip-General layer medium capacity
      3. GLH Sensor Chip-High capacity
      4. NLC Sensor Chip-Neutavidon
      5. HTG Sensor Chip-Compact capacity Tris-NTA for polyhistidine-tagged molecules capturing
      6. HTE Sensor Chip-High capacity Tris-NTA for polyhistidine-tagged molecules capturing
      7. LCP-Use with LCP capturing reagent kit for liposome capturing

Sensor chips are built with an alginate polymer matrix bound to a thin gold film on a sensor prism. The alginate matrix can be functionalized with several different reactive groups to facilitate different immobilization surface chemistries. The hydrophilic nature of the alginate layer creates a solution-like environment that prevents denaturation of the immobilized ligand and nonspecific absorption of the analyte.

GLC, GLM, and GLH sensor chips come functionalized with carboxyl groups to facilitate amine coupling of protein ligands via surface-exposed amine groups. On addition to serving as attachment sites, the carboxyl groups serve to concentrate the ligand at the surface of the sensor chip as the negatively charged carboxyl groups attract proteins that are positively charged.
1. **GLC Sensor Chip** has active carboxylic acid groups for covalent immobilization using primary amine groups. GLC Chip is designed to bind one analyte monolayer. It contains a thin alginate layer for amine coupling of ligands at low surface capacity. It is the ideal choice for protein-protein interaction analysis. It has a binding capacity of 500-8000RU.

![GLC Chip](image)

2. **GLM Sensor Chip** has active carboxylic groups for covalent immobilization using primary amine groups. GLM Chip displays a thicker carboxylic surface layer to provide higher ligand binding capacity. It is the ideal choice for protein-protein and protein-small molecule interactions. It has a binding capacity of 8000-13,000RU.

![GLM Chip](image)

3. **GLH Sensor Chip** stands for high capacity general amine coupling. It contains highly extended mixed polymer layer for maximum binding capacity. Further increased number of carboxylic acid groups for amine coupling to ligands from the highest density alginate layer. GLH is optimal for protein-small molecule and protein-protein interactions where highest sensitivity is required.

![GLH Chip](image)
4. **NLC Sensor Chip** contains neutravidin bound to polymer layer. NLC Chip is designed for immobilization of biotinylated proteins, peptides, and nucleic acids. The NLC Chip can capture ≈2,000 RU of IgG or ≈500 RU of DNA. Use this chip to immobilize ligands without amine coupling; however the ligand must be modified with biotin prior to immobilization.

![NLC Chip](image)

5. **HTG and HTE Sensor Chips** contain Tris-NTA(3-NTA) surface for improved capturing of His-tagged proteins. The His-tagged proteins can be directly captured from crude samples on the nickel(II)-activated Tris-NTA(3-Ni-NTA) surface for excellent binding stability. These chips can be used for protein-protein, protein-peptide, and protein-small molecules interactions.

![HTG Chip](image) ![HTE Chip](image)


Sensor Chips come in a sealed aluminum pouch. Try to open without ripping, so you can store chip back in pouch. Chips should be stored at -4°C. They should be allowed to warm to RT for at least 30 minutes, and keep in pouch until at RT. This will prevent condensation from forming on the prism. Each sensor chip is a glass coated prism containing alginate polymer. Each chip contains a barcode which should be read by SPR.

Maintenance procedures are performed following a set of wizards in the ProteOn Manager software. These wizards include Prime, Weekly, Post-Experiment, Clean MCM, and Syringe maintenance. The user will need to use Prime and Post-experiment maintenance procedures. Maintenance Chips are stored at room temperature, and they do not require initialization. Be sure chip is clean before inserting into instrument.

A. Below is picture of **Instrument Control** screen.

![Instrument Control Screen](image)


If SPR has been running in water for over a week, it is best to prime the system before a run. This will take about 50 minutes.

1. With **Maintenance Chip**, go to **Instrument** window.
2. Click on Prime box.
3. First place lines in ProteOn Maintenance **Solution 1** (2% contrad 70). Prime line A and line B.
4. Switch lines to ProteOn Maintenance **Solution 2** (70%IPA). Prime lines A and B with Solution 2.
5. Then return to **DI H2O** and prime lines A and B.


1. Buffers should contain a salt and a surfactant.
2. The recommended buffer is PBS with 0.005% Tween 20, PBS, and PBS/Tween/EDTA.
3. Other buffers could be Tween 80, CHAPS, or Triton.
4. Filter buffer solution through 0.22µm filter before using.
5. Avoid Azide and Tris buffers
6. There is a built-in degasser

D. Setting Chip Temperature- Refer to page 77 of ProteOn User Manual.pdf
1. In the Instrument Control Screen, you can set the Chip temperature. Once the Chip has been initialized, you can only set the Chip temperature in the Protocol Steps screen. You cannot change the chip temperature while an experiment is running.

![Chip Temperature Settings](image)

2. The temperature can be set from **15° to 40°C**.
3. Click on **Set** to apply the temperature setting.

1. In the Instrument Control Screen, you can hit the **Eject Chip** button.
2. Do not eject chip from Eject button on Instrument!
3. It will take about 30 seconds for the chip to reload into the cartridge before the chip ejects from the machine.
4. Count to 10, and then place the **new Chip into the slot**.


There are 3 initialization options when you load a chip.

1. **Air initialization**- button is only enabled the first time a chip is inserted.
2. **Glycerol initialization**- can be used for new or used chips.
3. **Use last initialization**- reusing a chip

- Choose one out of the three options to initialize chip and choose **Initialize Chip**. This will take a few minutes.

The Bio-Rad SPR is capable of running as many as 36 simultaneous individual interactions. The ProteOn XPR36 integrates a high-efficiency microfluidics system with a high-sensitivity optical system to analyze up to 6 ligands and up to 6 analytes. The SPR measurement occurs on the surface on the thin layer of gold coated on a high refractive index glass prism. The SPR effect on the sensor chip is sensitive to the mass of materials in the proximity of and/or bound to the chip’s surface. The sensitivity is shown as a shift of the minimum of an optical reflective curve. Any bound molecules change the mass of the material which in turn changes the effective index of refraction at the chip surface.

Protein interaction studies can give data of the following types:

- **Specificity and Identity** - yes/no binding of ligand and analyte, identification of interacting partners.
- **Binding Kinetics** - on/off rates of two molecules, association constant ($k_a$), dissociation constant ($k_d$).
- **Binding affinity** - strength of attraction between ligand and analyte, equilibrium analysis (KD).

**A. Experiment Steps**

1) **Preparation and Planning** - learn as much as you can about your interaction.
2) **Conditioning** (optional) - prepares sensor chip surface to increase data quality.
3) **Pre-Concentration** (optional) - decide which concentration of ligand is correct, pH scouting.
4) **Immobilization** - attaching ligand to the chip surface.
   a) **Direct Coupling** - through side chain groups on ligand-NH$_2$ for amine coupling.
   b) **Capturing** - the ligand on surface that is specific to ligand-Biotin/Neutravidin, His-tag/NTA, Ag/Ab.
5) **Stabilization** - Remove contaminants from surface and stabilize baseline.
6) **Interaction** - inject analyte at 4 to 5 concentrations, sufficient dissociation time to show off rate.
7) **Regeneration** (optional) - Remove analyte from ligand while preserving the ligand.
1) Planning and Preparation

Need to know:

- Molecule weight of ligand and analyte
- Solubility
- Isoelectric point-pI
- Storage temperature
- Concentration
- Salt
- Buffer
- Regeneration conditions
- Interaction data
- $R_{\text{max}}$

\[
R_{\text{max}} = n \frac{M_A}{M_L} R_L
\]

- $R_{\text{max}}$ = Maximum theoretical response of analyte for a given ligand level
- $N$ = Stoichiometric number of analyte-ligand interaction
- $M_A$ = Analyte molecular weight
- $M_L$ = Ligand molecular weight
- $R_L$ = Amount of ligand to be immobilized (ie mass )

- $R_{\text{max}}$ = 200RU
- Optical coupling = 1 pH unit below pI.
- For buffers, use non-ionic detergents, like Tween 20 or Tween 80, CHAPS, Triton.
- One can use up to 10% DMSO. If using DMSO over 2%, you should use EVC calibration.


Conditioning the chip will lead to optimal data. Follow Conditioning recommendations in the ProteOn Sensor Chip Tips and Techniques for your Sensor Chip. Refer to page 29 of this manual.

3) Pre-Concentration before Immobilization (optional) - Refer to page 219 of ProteOn User Manual.pdf
Pre-Concentration uses an inactivated sensor chip to study electronic attraction of ligand to sensor chip. This looks for efficient immobilization of ligand on surface of chip. Entails electrostatic attraction of ligand to chip surface through changes in buffer pH. Look at series of pHs to find highest concentration of ligand to the chip surface. Surface is not activated, this is only electrostatic attraction.

a) Prepare ligand at 20-50µg/ml in pH 5.5, 5.0, 4.5, 4.0 buffers.
b) Inject 30µl/min and observe binding response curves. Look at series of pHs to find highest concentration of ligand to the chip surface. Surface is not activated, this is only electrostatic attraction.
c) Use the highest pH.
d) Be sure unbound protein is rinsed offer with running buffers.


In the immobilization step, a ligand can be bound to the chip by direct coupling or by capture. In Direct Coupling, the functional groups on the ligand form covalent bonds with the carboxylic groups on the chip surface. For Capturing, a biomolecule is covalently bound to the surface of the chip, and this biomolecule is used as a specific recognition site for noncovalent capture of the ligand. An example of capturing would be if the protein was biotinylated and captured using avidin.


Covalent Immobilization using amine coupling
a) Conditioning for GLC, GLM, GLH, and NLC Sensor Chips
b) Activation
c) Immobilization
d) Deactivation
e) Stabilization

   - Conditioning cleans and prepares the chip’s surface. It can increase baseline stability.
   - Refer to page 29 of this manual, SPR Training manual.pdf.
   - Conditioning hydrates the polymer matrix and allows time for temperature stabilization.

Reactive groups are formed on the surface of the chip. The ligand is attracted to this surface and binds through amine coupling. An equi-volume mixture of EDAC and sulfo-NHS is used for activation. This mixture must be made fresh every time since it has a half-life of 30 to 60 minutes. A 1:5 dilution in H₂O or a 1:10 dilution in H₂O is recommended for GLC and GLM chips. For GLH chips, you may need a 1:1 dilution with H₂O

- 40mM EDAC and 10mM s-NHS 1:1 dilution in H₂O
- Mix last. Must be used in 30 to 60 minutes.


Many factors will influence the immobilization step including chip type, level of surface activation, ligand concentration and size, injection contact time, injection flow rate, and electrostatic attraction of ligand to surface. To optimize amine coupling, the chip surface will need an overall negative charge and the ligand needs to have an overall positive charge. This optimization can be determined by testing a series of different pHs. The ligand coupling buffer should be about 1pH unit lower than the pI of the ligand. One must take into account that the ligand still retains its activity at extreme pH ranges. Avoid azide and Tris buffers as these will compete with ligand.

For amine coupling, the ligand is immobilized in a buffer that ensures a net positive charge. This ensures that the ligand is attracted to the negatively charged chip surface. Bio-Rad offers sodium acetate buffers from pH 4.0-5.5 for amine coupling (refer to page 67 of SPR Training Manual.pdf).

- The ligand concentration should be about 0.5µg/ml to 25 µg/ml.
- A flow rate of 30µl.min is suggested
- Contact time should be from 1 to 5 minutes.
- Use Rₘₐₓ to determine ligand immobilization levels (page 3 of Ligand Immobilization Guide.pdf)

- Deactivation uses 1M ethanolamine to block any remaining activated carboxyl groups on the surface of the chip. This step is in the vertical direction which is the same direction as the activation and immobilization steps. The default injection parameters are 30µl/min for 5 minutes.
  - 1M Ethanolamine HCl
  - Deactivate unreacted s-NHS groups

It is recommended to inject buffer solution one or more times after the immobilization step. This will ensure that any noncovalently bound proteins are removed. Stabilization also creates a stable baseline for interaction analysis. It is recommended to stabilize the baseline for at least 30 minutes.

![Immobilization Protocols](image)


- In some cases, immobilization of the ligand to the chip surface may not be desired. Some applications may include antibody screening or capturing proteins using tags.
  - **Steps for Noncovalent Ligand Capture**
    1) Immobilization of capture reagent or biomolecule. NLC Sensor Chip is pre-prepared for biontinylated proteins.
    2) Injection of ligand to be captured.
    3) Removal of nonspecifically captured biomolecules.
    4) Stabilization of ligand capture.


Stabilization washes off any nonspecifically bound ligand from the chip surface. One or more blank injections can be performed to stabilize baseline. 30 minutes minimum recommended for stabilization.

On ProteOn XPS36 Instrument, the ligand and analyte are injected in perpendicular directions. Ligands are injected in the vertical direction while analytes are injected in the horizontal direction. The interaction of the ligand and analyte are measured as a change in refractive index over time. The concentration of the analyte should be 10x above and 10x below expected $K_D$.

During analyte step, injected analyte flows over immobilized ligand. There are two phases of SPR response:

- **Association Phase**- time that injected analyte interacts with ligand surface
- **Dissociation Phase**- time that analyte-free buffer flows over chip surface to cause the ligand-analyte complex to dissociate

- Knowing analyte concentration directly affects $K_a$ and $K_D$.
- Dilute analyte with running buffer to minimize bulk effects
- Be sure signal is stable before injecting
- Prepare 5 to 6 serial dilutions covering 0.1 to 10 times $K_D$.

$K_D = 10 \text{ nM} \quad \Rightarrow \quad \text{Use 1 nM to 100 nM}$
Useful tips for obtaining reliable interaction data

1. Analyte samples should be prepared as concentration series. The dilution series should be centered around the expected $K_D$.
2. Set up double reference. One of the six analyte channels contains running buffer to use as row reference or double reference. Double referencing corrects baseline drift correction. Or set up injection of buffer into all six analyte channels prior to analyte injection to use an injection reference.
3. Be sure association time of interaction is long enough to observe curvature. Also, allow dissociation time of interaction to be long enough to observe signal drop.

*Troubleshooting Analyte Injection on page 13-17 of ProteOn Sensor Chips Tips and Techniques.pdf*


A regeneration step removes any remaining analyte leaving the ligand surface ready for more experiments. The regeneration step can use acidic, basic, ionic, or detergent-containing buffer to remove the rest of the analyte. A good regeneration step strips off remaining analyte while maintaining the activity of the immobilized ligand.

- Use high flow rates of 100µl/min
- Minimum volumes of 30µl
- Start with mildest conditions

<table>
<thead>
<tr>
<th>ProteOn Regeneration Kit and Reagents</th>
</tr>
</thead>
<tbody>
<tr>
<td>176-2210</td>
</tr>
</tbody>
</table>

- It is highly recommended to condition sensor chips. This leads to improvement of data quality and rapid stabilization of baseline.

- **Conditioning**
  - Removes contaminants from new chip surface and fluidics
  - Prepares chip surface for experiment
  - Ensures stable baseline

1) GLC, GLM, and GLH Sensor Chip Conditioning.
   - Use same buffer that you plan to run experiment in.
   - Use 30µl/min injections

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Orientation</th>
<th>Composition</th>
<th>Volume, µl</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Regeneration</td>
<td>H</td>
<td>0.5% SDS</td>
<td>30</td>
</tr>
<tr>
<td>2</td>
<td>Regeneration</td>
<td>H</td>
<td>50 mM NaOH</td>
<td>30</td>
</tr>
<tr>
<td>3</td>
<td>Regeneration</td>
<td>H</td>
<td>100 mM HCl</td>
<td>30</td>
</tr>
<tr>
<td>4</td>
<td>Regeneration</td>
<td>V</td>
<td>0.5% SDS</td>
<td>30</td>
</tr>
<tr>
<td>5</td>
<td>Regeneration</td>
<td>V</td>
<td>50 mM NaOH</td>
<td>30</td>
</tr>
<tr>
<td>6</td>
<td>Regeneration</td>
<td>V</td>
<td>100 mM HCl</td>
<td>30</td>
</tr>
</tbody>
</table>

**Default Injection Quality and Needles Washes**

**Samples Layout**

<table>
<thead>
<tr>
<th>Solution</th>
<th>Volume</th>
<th>Rack Configuration</th>
<th>Microplate Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5% SDS</td>
<td>200 µl</td>
<td>L1–L6</td>
<td>H1–H6</td>
</tr>
<tr>
<td>50 mM NaOH</td>
<td>200 µl</td>
<td>K1–K6</td>
<td>G1–G6</td>
</tr>
<tr>
<td>100 mM HCl</td>
<td>200 µl</td>
<td>J1–J6</td>
<td>F1–F6</td>
</tr>
</tbody>
</table>

- This Preconditioning Experiment has been saved as **GL-X preconditioning**.
2) NLC Sensor Chip Conditioning

Trehalose is used as a protective layer for the NeutrAvidin on the chip surface. One or two blank injections of buffer prior to the first injection should ensure complete removal.

- Use same buffer for running the experiment.
- Flow rate of 30µl/min

<table>
<thead>
<tr>
<th>Step</th>
<th>Type</th>
<th>Orientation</th>
<th>Composition</th>
<th>Volume, µl</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Regeneration</td>
<td>H</td>
<td>1 M NaCl</td>
<td>30</td>
</tr>
<tr>
<td>2</td>
<td>Regeneration</td>
<td>H</td>
<td>50 mM NaOH</td>
<td>30</td>
</tr>
<tr>
<td>3</td>
<td>Regeneration</td>
<td>H</td>
<td>1 M NaCl</td>
<td>30</td>
</tr>
<tr>
<td>4</td>
<td>Regeneration</td>
<td>H</td>
<td>50 mM NaOH</td>
<td>30</td>
</tr>
<tr>
<td>5</td>
<td>Regeneration</td>
<td>V</td>
<td>1 M NaCl</td>
<td>30</td>
</tr>
<tr>
<td>6</td>
<td>Regeneration</td>
<td>V</td>
<td>50 mM NaOH</td>
<td>30</td>
</tr>
<tr>
<td>7</td>
<td>Regeneration</td>
<td>V</td>
<td>1 M NaCl</td>
<td>30</td>
</tr>
<tr>
<td>8</td>
<td>Regeneration</td>
<td>V</td>
<td>50 mM NaOH</td>
<td>30</td>
</tr>
</tbody>
</table>

3) HTG Sensor Chip Conditioning

- Use running buffer
- Flow rate: 30µl/min flow
C. Reusing Chips- Refer to page 78 of ProteOn User Manual.pdf

If the chip has had ligand immobilized on less than the 6 channels, you can use the unused channels for another experiment. Unused channels have not been exposed to reagents or conditions that would interfere with the next ligand immobilization. Chips must be stored back in aluminum foil and covered with paraffin. A small amount of glycerol can be added to top for storage. Keep horizontal in Refrigerator. Do not tip as that would allow moisture onto the prism.

9. Running an Experiment- Refer to Running an Experiment with the ProteOn XPR36 System laminated page in top drawer under computer
   A. Warm sensor chip to RT.
   B. Start the Bio-Rad XPR36 Instrument
      1) If the instrument is turned off, turn on the power to the instrument on the bottom left side. Refer to page 22 of ProteOn User Manual.pdf.
      2) Turn on the computer.
      3) Wait until all five instrument LEDs turn yellow.
      4) Launch ProteOn Manager Software.
      5) Wait until all 5 LEDs on instrument and Communication state on ProteOn Manager Software turns green.
      6) Follow instruction on screen to flush fluidics system.
   B. Initialize the sensor chip
      1) In the navigator panel, go to the Instrument tab and select Instrument Control.
      2) Press Eject to eject Maintenance Chip using the ProteOn Manager software.
      3) Place sensor chip for experiment in slot.
      4) Select chip initialization method and choose Initialize Chip.
      5) Wait for Chip Initialization to complete.
   C. Write a Protocol
      1) In menu bar, select File and choose New.
      2) Select New Protocol and press New Protocol button to start blank protocol or select an existing protocol and press New Protocol to copy selected protocol.
• **Protocol** means the set of instrument parameters, sample information, and running steps for an experiment.
• **Template** means a saved protocol intended to reuse.
• **Experiment** means an implemented protocol.

3) Select **Configuration** and edit protocol name and other information.
4) Select **Samples** and input necessary information.
5) Select **Steps** and drag steps one by one from the left side. In the **Steps Detail** panel, use arrow to select correct sample. If needed, adjust Flow Rate, Contact Time and Volume.
6) Select **Protocol Check** and review the information and look for red flags.

D. Run a protocol
1) Prepare and load samples in correct positions. Place sample container correctly into instrument with well A1 at bottom-left corner.
2) In navigator panel, select **Run** tab. Choose the protocol in the Selected Protocol/Experiment box.
3) Press **Run** to start experiment.
   a) Stop will stop the current step after it completes.
   b) Abort will stop the current step as soon as it is safe to do so.

E. Instrument maintenance
1) In the navigator panel, select **Instrument Control**. Press **Eject** to eject the sensor chip.
2) Insert **MNT chip** and software will go automatically to Maintenance screen.
3) Press **Post-Experiment**. Follow the instructions and press **Next** when ready.
4) Press **Standby** when complete.

F. Export experiment files
1) In menu bar, choose **File** and then select **Export**. Select Experiment/Protocol File to open database browser. Choose experiment file to export.
2) Press **Export** and choose location to export files.
3) Press **Save** to start export process. When finished, press **Close**.


Using ProteOn Manager™ software, you can open or create a protocol. Protocols contain configuration settings, sample information, and workflow for an experiment. You can load previously created protocols (Under file/Open) or create a new protocol by choosing File/New.

A. **To create a protocol from a template**:
1. Select **New** in the **File** menu.
2. Select a **template**.


4. **Edit** and **rename** the template.

**B. How to edit a protocol or template**

1) Open protocol or template (if you haven’t already)

2) Click on **Protocol** in the navigation panel, and a new window opens.

3) Edit the name, description, chip type, and autosamples configuration.
4) In the **Steps** screen, select a step and change its value in the step details area of the screen.

i. Click **Protocol** in the navigation panel, and then click on **Samples**. Click once for each new rack or plate needed. Analyte concentrations must be added before performing an analysis.
ii. Click **Protocol** in the navigation screen and then click **Steps**. Edit the protocol in this screen.

*You cannot edit protocol steps while running an experiment. You can, however, pause the run and then edit any steps that have not yet been performed.*

C. To save a protocol as a template—Refer to page 35 of ProteOn User Manual.pdf

1. Select **Open** in the File menu to open the database browser.
2. Select a protocol.
3. Click **Open** and the parameters will appear.
4. Edit the new protocol as required. In the file menu select **Save as Template** and rename file.
D. Creating a Protocol from Rack/Plate contents - Refer to page 36 of ProteOn User Manual.pdf

You can create a protocol without dragging steps from the Step list by using the Create Protocol option in the Samples screen. This option enables you to specify the typical step cycle of Blank, Analyte, and Regenerate steps. The cycle of steps is created for each analyte in the specific rack/plate.

1. Select the Protocol tab and then the Samples screen.
2. In the Step Creation area, choose Create Protocol.
3. The Create Protocol From Samples dialog box appears where you can build a cycle of steps.

4. In the Take samples from drop-down list, choose the rack/plate that you are using.
5. Click Create and a cycle of 3 steps is added to the protocol Steps list.
6. To repeat an injection or block, you can change the number of times to repeat an injection using the Repeat Injection box.
7. You can change the number of times to repeat the block by changing the number in the Repeat block box.


On the Protocol Configuration Screen, you can edit the protocol name, protocol description, view chip information, specify autosamples configuration and specify sample volumes to use in an experiment.

- To find the Protocol Configuration screen, in the navigation panel, click Protocol, and then click Configuration.
To configure a protocol:

a) Enter a new name in the name box.
b) In the description box, enter a description.
c) In the Chip panel, select a chip type from the arrow to the right of the box.
d) In the Autosampler Layout panel

F. Editing Protocol Sample Details

Click on Samples in the navigation panel to access the Protocol Samples screen. In this screen you can enter, review, and edit sample details. You can enter sample details before or after running the protocol. However, you must enter analyte concentrations before analysis.
G. Sample Panel Browser- Refer to page 45 of ProteOn User Manual.pdf

The Sample Panel Browser on the Samples screen shows the following for each sample panel.

1. **Rack/Plate ID** displays the identification number assigned to the plate.
2. **Panel Name** displays the user-defined name.
3. **Required Volume** tells the minimal sample volume needed. Inject about **25µl more** than needed.

   \[ \text{Rec. Vol} = \text{Tube Dead Vol} + \sum_{n \text{Where Used}} \left( \text{Dead Vol} + \text{Inject Qual}_n \times \text{Plug Vol} + \text{Inject Vol}_n \right) \]

   Where:
   - Tube Dead Vol = 25 µl
   - Dead Vol = 35 µl
   - Inject Qual = 1, 2, or 3
   - Plug Vol = 8 µl
   - \( n \) Where Used or \( n \) = the number of steps that use the sample panel

4. **Where Used** lists the steps that use this panel.
5. **Type** has a pulldown menu or is determined by a protocol step.

<table>
<thead>
<tr>
<th>Panel Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activator</td>
<td>Reagents used in an activation step</td>
</tr>
<tr>
<td>Ligand</td>
<td>Ligands used in a ligand immobilization step</td>
</tr>
<tr>
<td>Deactivator</td>
<td>Reagents used in a deactivation step</td>
</tr>
<tr>
<td>Regenerator</td>
<td>Reagents used in a regeneration step</td>
</tr>
<tr>
<td>Analyte</td>
<td>Analytes used in an analyte step</td>
</tr>
<tr>
<td>Blank</td>
<td>Buffers injected in a blank step as part of a chip equilibration process or to generate data for double referencing</td>
</tr>
<tr>
<td>EV Correction</td>
<td>Reagents (usually DMSO) used to generate an excluded volume correction curve</td>
</tr>
</tbody>
</table>
6. Sample Information consists of sample name, concentration (M, mM, µM, pM and mg/ml). Keep Type as Undefined.

7. You can copy or move sample panel by dragging to new position.

8. Autosampler Layout
   a) The different colors of the sample panel represent different sample types (activator, regenerator, etc.)
   b) You can click on a column of samples to bring sample panel into focus.

H. Creating and Editing Protocol Steps

Refer to page 48 of ProteOn User Manual.pdf

On the Protocol Steps screen, one can create a protocol by adding, deleting, and modifying protocol steps and sep groups. The Protocol Steps screen is made up of the Protocol Editor panel and the Steps Details panel. To access the Protocol Steps screen:

- In the navigation panel, click on Protocol and then Steps.

Protocols for SPR analysis can consist of up to 12 types of steps. The Protocol Editor can be used to add or delete steps or step groups. If you use a template, the step list automatically populates, and one can edit the steps if needed.

![Protocol Editor](image)

a) To add a step or group to Protocol Steps List:
   i. Drag the element from the step or group anywhere into the Protocol Steps list. New items are inserted under the selected group.
   ii. Double-Click a step or step group to have it appear at the bottom of the Protocol Steps list.

b) To place new step between existing steps, press the Shift key while dragging the new step into position.

c) To reposition a step or step group, drag it to the new location.

d) To delete a step, select the step and click Delete at the top of the Protocol Steps screen(red X). Or right click with mouse and choose Delete.
J. Step Group List

<table>
<thead>
<tr>
<th>Step Group</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Immobilization</td>
<td></td>
<td>Includes Activate, Ligand, and Deactivate Steps</td>
</tr>
<tr>
<td>Stabilization</td>
<td></td>
<td>Includes stabilization of the sensor chip surface using a Blank step and a Regenerate step</td>
</tr>
<tr>
<td>Interaction</td>
<td></td>
<td>Includes an Analyte step and a Regenerate step</td>
</tr>
<tr>
<td>EVC Calibration</td>
<td></td>
<td>Includes EVC Calibration steps</td>
</tr>
</tbody>
</table>

The immobilization step group includes Activate, Ligand, and Deactivate Steps. It is the only group you would need to Use. EVC Calibration is for using more than 3% DMSO. DMSO has high RI, so this would help reference for high DMSO content in your running buffer. This EVC calibration will be covered in a separate procedure (Refer to Excluded Volume Correction Guide.pdf or page 83 of ProteOn User manual.pdf)

The following Step types are listed in the Steps list. Just drag to where the step is needed.
- **Pause** is a great step to add in case you are not sure whether to proceed to the next step or waiting for a stable baseline. Refer to page 45 of SPR Training Manual.pdf.


There are 2 Paste options available: Paste and Paste Replicate

- **Paste** creates a new step using all the parameters except not sample location. For Blank or Regenerate, the Paste option will uses the same well until it is empty.
- **Paste Replicate** copies all the parameters including sample location. This option tells you when you have overdrawn your sample.
  1. To copy or paste a protocol step, select the step or step group in the Protocol Steps list.
  2. Select Copy in the Edit menu or right click with mouse and choose copy.
  3. Select another step in the Steps list, and select Paste or Paste Replicate in the Edit menu or with a right mouse click.
  4. The pasted step appears below the selected step.


In Protocol Steps, clicking on an item populates its parameters in the Step Details panel.

- View and edit injection step parameters
- Create or assign sample panels to an injection step
- Show the interaction layout

This lists protocol types, though not all can be changed.

<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step Types</td>
<td>Allows you to select Activate, Ligand, Deactivate, Regenerate, Analyte, Coinject Ligand, Coinject Analyte, Pause, Set Temperature, Set Buffer, and Change Rack</td>
</tr>
<tr>
<td>Step Name</td>
<td>Applies when a new step is added to the Protocol Steps list. The step is given the name “Step Type + n,” where n indicates that the step is the nth step of that type created. You can change the name in the Step Name box</td>
</tr>
<tr>
<td>Flow Rate</td>
<td>Rate at which fluid flows through the channels. This parameter applies to all stages of a step. If this value is changed, contact time is recalculated using the current volume</td>
</tr>
<tr>
<td>Contact Time</td>
<td>Amount of time that an injected sample is in contact with the sensor chip surface. Contact time = injection volume/flow rate. If this value is changed, volume is recalculated at the given flow rate</td>
</tr>
<tr>
<td>Volume</td>
<td>Equals the volume of the injected sample. If this value is changed, contact time is recalculated at the given flow rate</td>
</tr>
<tr>
<td>Dissociation</td>
<td>The time period when a biomolecular complex is allowed to dissociate into its separate components. This parameter appears in the Analyte, Coinject Analyte and Blank injection steps, as well as in the Advanced settings dialog box</td>
</tr>
<tr>
<td>Advanced</td>
<td>Overrides default settings for each step. To edit the parameters, clear the Use Default checkbox</td>
</tr>
</tbody>
</table>


This is located at the bottom of the Step Details panel. It displays the orientation of the current injection and the direction of flow for the sample. It indicates how the samples are to interact with each other.

1. The chip view is **vertical** for the Activate Ligand, Deactivate, and Coinject Ligand steps.
2. The chip view is **horizontal** for the Analyte, Blank, Regenerate, and Coinject Analyte steps.

![Chip View](image)

**O. Setting the Buffer Step**-Refer to page 55 of ProteOn User Manual.pdf

The step would be used to switch between Buffer A and Buffer B. This is done usually in an experiment using DMSO. Immobilization is done first without DMSO, and the interaction is measured with DMSO in the running buffer. Once the buffer is switched, the protocol must pause to wait for selected buffer to be flushed through fluidics system.

![Buffer Step](image)

- In the Protocol Editor panel, select the Set Buffer step.
- When the Set Buffer step executes, the buffer valve position changes the buffer position, and the instrument does a flush operation. After flushing, there is a 15 second delay, and the SPR curve is recalculated.

**P. Setting the Temperature Step**-Refer to page 56 of ProteOn User Manual.pdf

The Set Temperature step can change the chip temperature during an experiment. The protocol will pause until the chip reaches the desired temperature. It is recommended to wait 45 to 60 minutes for a 5°C change.
1. In the **Protocol Editor**, select **Set Temperature** from the Steps list.
2. The temperature range is 15-40°C.
3. You can enter a wait time of up to 24 hours.

**Q. Setting the Change Rack Step** - Refer to page 57 of ProteOn User Manual.pdf

During any point in the protocol, you can switch between sample holders. When a change rack executes, the protocol pauses until the pause time runs out or until you click on the Start in the Run screen.


1. Drag the Pause in the Step list into Protocol Steps list.
2. You can type a reason in the Pause Message box.
3. You can select the Enable Pause Time Out box to enter a specific pause time before the experiment resumes. Or leave the experiment in Pause.

The Protocol Check combines the entire protocol in tabular form. The table makes it easy to double-check large protocols before running an experiment. The steps are color coded; the total volume needed is displayed. If the total volume required is over capacity, the amount is displayed in red.

- Click **Protocol Check** in the navigation pane to display the protocol table
- To change order of columns, select a column and drag it to a new location.


ProteOn GLC, GLM, and GLH sensor chips that are used for amine coupling require activation of the carboxyl groups on the surface of the chip. Amine coupling uses two activating agents which are stable for the duration of the ligand immobilization process, and they must generate an effective leaving group to be replaced by the ligand. These reagents form esters that interact with amine groups on the ligand.

- 40mM EDAC and 10mM sulfo-NHS
- Equal volume mixture: 1 to 1
- Mixture is not stable 30 to 60 minutes
Sulfo-NHS (N-hydroxysuccinimide) and EDAC [1-ethyl-3-[3-dimethylaminopropyl] carbodiimide HCl activate the chip surface carboxyl groups and they immobilize ligand proteins to the chip surface. EDAC activates carboxylic groups and it detaches rapidly. Sulfo-NHS assists coupling in the presence of EDAC. It forms an intermediate active ester that reacts further with the amine group on the ligand to create an amide bond. Sulfo-NHS carries a full negative charge on the chip surface after activation to enable more efficient coupling.

To dissolve and aliquot

1. Store EDAC and s-NHS at -20°to -80°C.
2. Add 75 ml cold DI H₂O to EDAC bottle = 40 nM.
3. Add 75 ml cold DI H₂O to s-NHS bottle = 10 mM.
4. Mix in 1:1 ratio dilution immediately prior to use.

Mix EDAC and s-NHS immediately prior to use!


A. After you have made protocol and experiment preparations, it is time to run your experiment.
B. Choose the Run tab in the navigation panel.
C. Select a protocol to run using the Selected Protocol/Experiment pull-down list in the Run tab.
D. In the Run tab, click Start.
   1) Click on Stop to stop an experiment before the next protocol step. It will finish the current step.
   2) Abort will stop the run immediately, when it is safe to do so.
The run screen shows the data in progress. As each step finishes, you can see the data on the Data screen. You can analyze data while an experiment is in progress.
13. Referencing

- Removes any contributions to the interaction response due to the following:
  a. Bulk effects- Refractive index changes due to differences between running buffer and sample buffer.
  b. Baseline drift
  c. Non-specific binding events

There are two types of Reference Surfaces

1. Blank surface with analyte solution (ligand-freespot)
2. Same surface with blank buffer
There are two types of surfaces: Blank Reference and Blank Buffer injection

A. Blank Surface –Option 1: Channnel Reference

This option is a traditional reference type in SPR biosensors. It reserves blank interaction spots for reference.
Option 2- Interspot Reference

This option is a unique reference type in the ProteOn system. It has two special advantages.

Advantage 1: Close to interaction spots
Advantage 2: Saving interaction spots consumed in conventional channel reference
B. Blank Buffer Reference-Option 1- Injection Reference

This option is a traditional reference type in SPR biosensors. It requires injection of blank buffer prior to analyte injection.

Option 2- Real-Time Reference

This option is a unique reference type in the ProteOn system. It has two special advantages. 

Advantage: “Real-time” monitoring over the ligand surface

Blank Analyte Channel
14. Analysis

- Analysis Interaction data comes in two forms: sensorgrams and tabulated numerical data. Sensorgrams are graphs of responses versus time, and they are organized and displayed on the Data and Analysis Datasets screens. Tabulated analysis data includes kinetic rate, equilibrium constants, concentrations, and statistical analysis. These appear at the bottom of the screen.

A. Sensorgram Data Windows

Raw, processed, and analyzed sensorgrams appear as color-coded graphs in separate data windows. A vertical dotted line indicates start and stop times of each injection. The header of each graph contains the name of the protocol step and data grouping selected. There is a legend in each data window explaining sensorgram color coding. Hovering a mouse over an area on the sensorgram will display an annotation that contains the trace legend and position for that selected point.

Hovering the mouse over the legend in the data window will show an annotation of the sample name and injection step number.
B. Zoom

Zoom in by right-clicking and dragging an area of interest. Zoom out by double-clicking in the zoomed window or by choosing Zoom Out toolbar option.

C. Showing Interspot Data

Interspot are the areas where there is no ligand. Showing Interspot lines up the interspot data with the interaction data.

- On the View menu, select Show Interspot Data.

D. Data Filters and Display Controls

In the Navigation panel, there are 5 controls to view and organize datasets for processing and analysis: Panel Type, Protocol Step, Data Grouping, and Interaction. Data windows are redrawn when a selection in these controls is changed and Apply is pressed.

1) Panel Type- Select one of the seven panel types to display.

![Panel Type](image)

2) Protocol Step-Use to select interaction datasets to display.

![Protocol Steps](image)
3) Data Grouping—Organize sensorgrams into data windows. Groups data for processing and analysis.

![Data Grouping Window]

**Window Grouping**
- Group by Analyte combines sensorgrams associated with 1 analyte channel into 1 window.
- Group by Ligand combines sensorgrams associated with 1 ligand channel into 1 window.
- Group by Spots combines sensorgrams associated with their spots.

**Analysis Grouping within Data Grouping Window**
- Do Not Combine—displays all sets in separate windows depending on selected grouping
- Combine Across Steps—combines data across protocol steps to display in 1 window.
- Combine and Concatenate Steps—Displays data from multiple protocol steps chronologically.

4) Interaction
- Choose Interaction in the Data tab

![Interaction Display Chooser]

- Controls the display of interaction data
- Select or deselect sensorgrams for processing and analysis
- Click an interaction in grid to change it from visible to hidden

**E. Isoaffinity Graph**

The isoaffinity graph allows you to visualize kinetics or plotting the association values and the dissociation values. Association ($k_a$) is plotted on the x-axis, and dissociation ($k_d$) is plotted on the y-axis. The isoaffinity ($k_D$) is displayed on the diagonal line.

- Open an experiment that includes kinetic data
- In the navigation panel, choose Analysis Dataset and then select kinetic analysis.
• Choose Isoaffinity graph in the analysis menu

15. Processing Data

Processing isolates, aligns, and cleans up informative segments of your sensorgram. The processing history of each dataset is saved and this processing can be undone. Any automated processing operations will be performed on all sensorgrams in the display. When you add additional sensorgrams to the display, the same processing operations will automatically be applied to the new sensorgram.

A. Selecting a Range on a Sensorgram

To choose a region on a sensorgram, right-click and drag the mouse over the area. The selected area turns gray, and the legend and position will appear. The range Boundaries can be changed by dragging them.
B. **Auto Process**

Auto Process can be found on the Process menu or on the toolbar. It will automatically perform the following tasks simultaneously:

- Injection alignment
- Baseline alignment
- Artifact removal

C. **Injection Alignment**

Injection Alignment is found in the Process menu of the toolbar. Choose it to align the y-axis and set the baseline for the sample. The baseline can be adjusted automatically, **Auto**, or **Selected**, where you select the region.

D. **Artifact Removal**

SPR signal artifacts can occur from pump refilling, injection valve switching, and accidentally injecting air bubbles. These artifacts can be removed by two ways:

- Auto-all data is scanned and artifacts causing bad data are removed automatically.
- Selected-removes all data in the region you select and draw black line from start and end points.
  1) Choose **Artifact Removal** on Process menu and select **Auto**.
  2) Right-click and drag to define region containing artifact. Choose **Selected** on the Process menu.

E. **Performing Reference Subtraction**

There are two types of reference subtraction: Channel Reference and Double Reference.

1) **Channel Reference**

This will perform channel reference using data collected on a channel that does not have ligand immobilized or by using interspot data.

i. In the Process menu, choose **Channel Reference**.
ii. Select Interspot, Column, or Row
iii. Column leads to choosing L1 to L6.
iv. Row leads to choosing A1 to A6.
2) Double Referencing

This referencing is performed by collecting interaction data using a blank sample. This referencing eliminates artifacts that result from ligand surface, such as drift and nonspecific binding.

I. In the Process menu, choose Double Reference.

II. Select Row Reference, Column Reference, Blank Reference or Injection Reference.
   a) Row Reference - Up to 5 analytes and 1 blank sample are injected. The blank reference can be located in any channel.
   b) Column Reference - When analytes are run in the vertical direction, a column reference can be used. Up to 5 analytes and 1 blank sample are injected. The blank reference can be located anywhere.
   c) Blank Reference – Use this when one of the analyte samples is defined as Blank type.
   d) Injection Reference - This will open a wizard for double reference selection.

F. Remove Processing

In the View menu, choose Remove Processing to restore processed dataset to original state.

G. Creating Report Point

Report Point can be used for graphing ligand analysis and results.

1) Auto Process your spectrum of interest.
2) Use Reference Subtraction.
3) Click on the X
5) Click on specify report point range manually box and enter the correct timepoints.
6) Hit Create and a Report Point will be generated.
7) To save report:
   a) Right click on graph and choose copy graph. Paste graph in excel.
   b) Right click on report at bottom and choose select all, then copy. Paste report in excel.

H. Creating a Dataset

1) In the Data tab on the navigation panel, click Create Dataset to save processed data.
2) Enter a **name** in the Create New Dataset dialog box.
3) Click **Create**.
4) The dataset name will now appear in the Analysis Dataset tab. Now, you can perform kinetic, equilibrium and concentration analysis on this data.


The Analysis Dataset screen can be used to perform kinetic, equilibrium, and concentration analysis. A wizard performs a fit process and parameters evaluation on the data.

a) On the Analysis Dataset screen, click on the dataset to be analyzed.
b) Choose the type of analysis wizard to run on the dataset

There are 3 types of Analysis Wizards: Kinetic analysis, equilibrium analysis, and concentration analysis


- Kinetic Analysis fits a set of sensorgrams to a biochemical interaction model and extracts an estimated value for each of the model’s kinetic parameters.
1) Select processed dataset on the Analysis Sets screen and choose **Kinetic**.

![Kinetic selection](image)

2) Select a Biochemical Model. There are 7 models available, but Langmuir is the most popular. Click on **Next**.

![Model selection](image)

3) Adjust the markers for start/stop association and start/stop dissociation. By default, the association and dissociation regions will appear shaded grey in the graph. The Begin and End times can be changed by changing values in the table or by moving the grey shaded areas on the graph.

![Graph with markers](image)

4) Define Analysis parameters.
   a. Select Scope by choosing Global, Local, or Group on the pull-down list.
   b. Select Type by choosing Fitted or Constant from the pull-down list.

<table>
<thead>
<tr>
<th>Fit Type</th>
<th>Scope</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>Global</td>
<td>During analysis, one value is selected</td>
</tr>
<tr>
<td>Fitted</td>
<td>Global</td>
<td>During analysis, one value is calculated</td>
</tr>
<tr>
<td>Local</td>
<td>Grouped</td>
<td>Single initial value is selected for all sensorgrams</td>
</tr>
<tr>
<td>Grouped</td>
<td>Local</td>
<td>Single initial value is selected for each sensorgram</td>
</tr>
</tbody>
</table>

**Global**-parameters identified for all sensorgrams.  
**Grouped**-parameters are identified only for a certain ligand.  
**Local**-parameters are independent for each sensorgram.
5) Click **Next**, and the wizard calculates the fit. A table appears with the Report tab open. Calculate $K_a$, $K_d$, $K_{D}$, $R_{\text{max}}$.

![Table with data](image)

Chi$^2$ measures a difference between actual data and fitted data. This number should be less than ten. The black lines should be close to the data, as well.

6) Icons appear in the left margin of the dialog box
   i. **Report** will open the table summarizing numerical results.
   ii. **Residual** will open kinetic analysis residuals graph. This graph plots the calculation residuals along the y axis and the experiment time along the x-axis.

![Residuals graph](image)

The residuals are another way to look and see if data analysis is correct.

7) Click **Finish** to save

8) To copy Analysis Report into pdf, under **File**, choose **Print**, then **Analysis Report**.

9) Check or uncheck report options and choose **OK**.

10) Under **File**, choose **Export Document** to **PDF File**. Save in folder and/or USB drive.

- Equilibrium analysis derives the equilibrium parameter $K_D$ from a set of sensorgrams that have reached steady state.
  1) Select processes dataset on Analysis Datasets screen and choose **Equilibrium**

  ![Equilibrium Analysis Wizard](image)

  2) Select regions for $R_{eq}$ calculation and analysis parameters. Use the Zoom In tool and drag the vertical bars in a sensorgram region for x-start and x-stop. Confine the fit region to areas where the signal is flat.

  ![Sensorgram Analysis](image)

  3) Define Analysis parameters.
     a) Select Scope by choosing Global, local, or Grouped from pull-down list.
     b) Select Type by choosing Fitted or Constant from pull-down list

  ![Analysis Parameters](image)
4) Click **Next** when finished. This will calculate $K_D$.

5) **Results Preview**

6) The wizard calculates equilibrium parameters by analyzing the dependence of $R_{eq}$ on an analyte concentration ($C$). The results include:
   - Equilibrium ($R_{eq}/C$) curves
   - Calculated parameter values
   - Statistics of the fitting process ($\chi^2$)

7) Click **Finish** to save the analysis.

8) To copy Analysis Report into pdf, under **File**, choose **Print**, then **Analysis Report**.

9) Check or uncheck Report options and choose **OK**.

10) Under **File**, choose **Export Document to PDF File**. Save in folder and/or USB drive.

- Concentration analysis calculates the concentration of the analyte based on a set of known concentration samples. For each known sample, the sensorgram is analyzed to determine its slope at the start of the injection. These slopes are plotted as a function of known concentrations to generate a standard curve where the concentrations of the unknown samples can be determined.
  1) In the Protocol Samples screen, define sample concentrations and sample types
     a) Standard-Samples with known concentration used to calculate the standard curve
     b) Control-Samples with known concentration used to verify the quality of standard curve.
     c) Unknown-Sample whose concentration will be calculated from the standard curve.
  2) Select a processed dataset for analysis and choose **Concentration**.
3) Select a region for analysis by double-clicking the sensorgram. One can move the vertical bars. Choose X-start and X-stop.

4) Define analysis Parameters.
   a) Parameters include $R_{\text{low}}$ and $R_{\text{hi}}$ (the lowest and highest response), $A_1$ (mid-range concentration), $A_2$ (slope factor), and Concentration.
   b) You can select Global, Local, or Grouped in the pull-down list.
   c) You can select Fitted or Constant in the pull-down list.

5) Click **Next** to continue with wizard.
6) Results Preview shows the analysis results. Go back to previous step if you need to make changes.
7) Click **Finish** when done.
8) Copy and paste or export data.

ProteOn Manager automatically saves data. You can also export analysis data to a word processing file, and you can export sensorgram data into a Microsoft Excel file as a table or graph. You can also copy and paste the sensorgram graph as a bitmap image into a presentation program.

A. Exporting Data to a File

1) On the File menu, select Export, and choose type of data to export.

2) In the Export dialog box, choose a file location to export data to or USB drive.

18. Post-Experiment Cleaning

Postexperiment cleaning should be performed when all experiments are complete sign your sensor chip or when you are switching chips.

- cleans the fluidics and MCM
- removes proteins and salts from fluidics and MCM
- requires Maintenance Chip
To run Post-experiment cleaning wizard:

A. Change running buffer to **DI H$_2$O**
B. Insert **Maintenace Chip**
C. Go to the **Instrument** tab in the navigation screen
D. Choose **Maintenance**, then click on **Post-Experiment**
E. Load solutions in sample rack designated for Post-Experiment cleaning following wizard
F. 520µl of 2% Contrad-70 in H7-H12
G. 520µl of 20mM HCL in G7-G12
H. 520µl of DI H$_2$O in F7-F12
I. Click **Next** in wizard when samples are ready
J. This takes about 50 minutes to complete.

- **Raw Data**
  - Under **File**, select **Open**.
  - Choose an experiment to display. In navigation area, choose **Data** tab.

- **Open File**
  - Open **Panel Type** and select step type. Click **Apply**, and then **Close**.

- **Panel Type**
  - Open **Protocol Step** screen, and select step to display. Click **Apply**, and then **Close**.

- **Protocol Step**
  - Open the **Data Grouping** screen and choose grouping option. Click **Apply**, and then **Close**.

- **Data Grouping**
  - Under **Process** from menu bar, choose **Auto Process**. This includes baseline alignment, injection alignment and artifact removal.

- **Auto Process**
  - Under **Process**, select **1st Reference**.
  - **Channel Reference**. Choose blank surface reference.

- **1st Reference**
  - Under **Process**, select **2nd Reference**.
  - **Double Reference**. Choose appropriate blank buffer reference.
Open **Interaction screen** and deselect the interaction spots that will be excluded. Click **Apply**, and then **Close**.

Open the **Create Dataset** screen, and define a name. Click **Create** to form a dataset of processed sensorgrams.

**Good Sensorgram?**

- **NO** Troubleshooting with the data processing steps.
- **YES** **Processed Data**
Choose appropriate kinetic fitting model (Langmuir). Click Next.

Select Analysis Dataset from navigator sidebar. Choose dataset to fit.

Type of Analysis

Kinetics
- Select Analysis and choose Kinetic.

Equilibrium
- Select Analysis and choose Equilibrium.

Concentration
- Select Analysis and choose Concentration

Choose model

Set parameter
- Inspect displayed regions and settings for analysis parameters. Click Next to analyze sensorgram.

Review Result
- The Calculated SPR results are displayed in report table. Click Finish to save the fitted sensorgram.

Good SPR?
- NO: Troubleshoot with data processing steps.
- YES: SPR Result
20. Ordering Information from Bio-Rad

A. Amine Coupling Kit

Reagents (176-2410)
- EDC
  - 1.15 mg in a 30 ml amber glass bottle.
  - Dissolve in 15 ml water, aliquot and store at -20 (-80 C preferred).
  - Enough material for ~100 injections.
- Sulfo-NHS
  - 0.172 g in a 30 ml amber glass bottle.
  - Dissolve in 15 ml water aliquot and store at -20 (-80 C preferred).
  - Enough material for ~100 injections.
- Ethanolamine hydrochloride - 1 M (176-2450)
  - 25 mL in a 60 ml polypropylene bottle.
  - Enough material for ~100 injections.
- Kit Storage: -20 °C

B. Immobilization Kit

Kit Components (176-2110)
- 10 mM Sodium Acetate pH 4.0 (176-2120)
- 10 mM Sodium Acetate pH 4.5 (176-2121)
- 10 mM Sodium Acetate pH 5.0 (176-2122)
- 10 mM Sodium Acetate pH 5.5 (176-2123)

Each component
- 50 mL
- 0.2 um filtered
- Storage: 4°C
C. Regeneration Kit

Kit components (176-2210)
- 10 mM Glycine Hydrochloride pH 1.5 (176-2220)
- 10 mM Glycine Hydrochloride pH 2.0 (176-2221)
- 10 mM Glycine Hydrochloride pH 2.5 (176-2222)
- 10 mM Glycine Hydrochloride pH 3.0 (176-2223)
- 50 mM Sodium Hydroxide (176-2230)
- 0.5% Sodium Dodecyl Sulfate (176-2240)
- 100 mM Hydrochloric Acid (176-2250)
- 0.85% Phosphoric Acid (176-2260)
- 1 M Sodium Chloride (176-2270)

Each component
- 50 mL in a 60 ml polypropylene bottle.
- 0.2 um filtered

D. Running Buffers

Buffers
- PBS, 10 mM Phosphate, 2L (176-2710)
  - 150 mM Sodium Chloride pH 7.4
- PBST, 10 mM Phosphate, 2L (176-2720)
  - 150 mM Sodium Chloride pH 7.4
  - 0.005% Tween 20
- PBSTE, 10 mM Phosphate, 2L (176-2730)
  - 150 mM Sodium Chloride pH 7.4
  - 0.005% Tween 20
  - 3 mM EDTA

All buffers:
- Storage: 4 °C
- 0.2 um filtered
E. Accessories

Microplates
- Standard polypropylene microplates, 25/pk (176-6020)
- 2.0 mL deep well plates, 5/pk (176-6023)

Sealing Tape
- 50 sheets/pack (176-6040)

Microtubes
- 1.5 mL, piercable, 100/pk (176-6010)

F. Sensor Chips

![Chip Selector Diagram]

- GLC: Compact Capacity Amine Coupling for Protein-Protein Interactions
- GLM: Medium Capacity Amine Coupling for Protein-Protein and Protein-Small Molecule Interactions
- GLH: High Capacity Amine Coupling for Protein-Small Molecule Interactions
- NLC: NeutrAvidin for Biotinylated Molecule Capturing
- HTG: Compact Capacity Tris-NTA for Polyhistidine-Tagged Molecules Capturing
- HTE: High Capacity Tris-NTA for Polyhistidine-Tagged Molecules Capturing
- LCP: Used with LCP Capturing Reagent Kit for Liposome Capturing

![Sensor Chip Table]

<table>
<thead>
<tr>
<th>Catalog Number</th>
<th>Product Name and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>176-5012</td>
<td>ProteOn GLM sensor chip, for general amine coupling, polymer matrix layer with intermediate binding capacity</td>
</tr>
<tr>
<td>176-5013</td>
<td>ProteOn GLH sensor chip, for general amine coupling, polymer matrix layer with high binding capacity</td>
</tr>
<tr>
<td>176-5021</td>
<td>ProteOn NLC sensor chip, for binding of biotin-labeled molecules, contains NeutrAvidin immobilized to GLC layer</td>
</tr>
<tr>
<td>176-5031</td>
<td>ProteOn HTG sensor chip, for capturing of His-tagged proteins, polymer matrix layer contains tris-NTA complexes</td>
</tr>
<tr>
<td>176-2500</td>
<td>ProteOn HTG capturing kit, includes 1 ProteOn HTG sensor chip and 1 ProteOn HTG reagent kit</td>
</tr>
<tr>
<td>176-5100</td>
<td>ProteOn MNT maintenance chip, for use in maintenance protocols</td>
</tr>
<tr>
<td>176-5110</td>
<td>ProteOn CLN cleaning chip, for use in microfluidics network cleaning protocol</td>
</tr>
<tr>
<td>176-2810</td>
<td>ProteOn chip normalization solution, 50% glycerol, 100 ml</td>
</tr>
</tbody>
</table>